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WARNINGS AND CAUTIONS 

 
WARNING 
 
The MultiLog data logger contains Lithium-ion batteries. The used batteries must be disposed of in 
accordance with Local Environmental Regulations. 
 
Radcom Technologies Ltd offers the service of equipment and battery disposal. 
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1 Abbreviations and Definitions 

BAUD RATE Measurement of Data speed between instruments using serial 
communication 

DMA    District Metering Area 
GPRS    Global Packet Radio Service 
GSM    Global Service for Mobile Communications 
LAN    Local Area Network 
PDA    Personal Digital Assistant 
PDU    Packet Data Unit 
PIT    Pulse Interval Time 
PSTN    Public Switched Telephone Network 
RADLINK   Keypad unit for setting Radcom Loggers & Downloading data 
RADLOG FOR WINDOWS Industry standard software for data trending, reporting, analysing and 
archiving 
RADWIN (LITE)   Simple RadWin Software for configuring Data Loggers 
RAM    Random Access Memory 
SIM    Security Identity Module 
SIMM    Single Inline Memory Module 
SMS    Short Messaging Service 
WAN    Wide Area Network 
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2 Introduction 

This manual has been produced as an Informative User Guide to the MultiLog Range of Data Loggers, 
designed and manufactured by Radcom Technologies Ltd. 
 
The manual provides an introduction to the data loggers, presenting the essential information required for the 
user to gain a clear understanding of the equipment and its uses. 
 
The manual includes an overview of the MultiLog Data logger, including: 
 
• Physical Construction 
• Functional Operations 
• User Applications. 
 
and contains instructions on how to: 
 
• Install the Hardware 
• Obtain and Install the necessary Software 
• Configure the MultiLog with the Software 
• Interact with the MultiLog to gain the data required. 
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3 The MultiLog Data Logger 

The Radcom (Technologies) Ltd MultiLog Data Loggers have been designed as high specification telemetry 
or portable data loggers, incorporating the latest technology and data compression techniques to make them 
the most cost effective, advanced and flexible data loggers yet. 
 
The MultiLog Data Loggers are used for the monitoring and control of water distribution pipe networks and 
leakage reduction, the monitoring of dirty water and effluent discharges, river level monitoring and flood plain 
warning solutions. 
 
The logger can be supplied with up to four inputs to monitor any combination of digital or analogue signals. 
Each input has a primary recording channel and secondary (fast sampling) channel that are independently 
programmable. This enables, for example, the primary channel to be used for normal recording and reporting 
purposes and the secondary channel to be used for diagnostic purposes. The logger also has a pseudo 
recording channel that can be programmed to store summary data. 
 
The logger can be supplied in portable mode or with a telemetry link provided by a telephone line using an 
internal PSTN modem or by using the cellular communications network with an internal GSM modem. 
 
All of Radcom’s Data Loggers and Controllers are compatible with RadLog for Windows, the industry 
standard software for data trending, reporting, analysing and archiving. 
 
Main features of the MultiLog Data Logger include: 
 
New and fast data communications protocol 
Count and Event logging modes 
PSTN Modem speed up to 2400 baud 
RS232 communications at 19,200 baud 
Normal Configuration 2 Digital and 2 pressures complete with hoses 
Second recording for fast sampling, step testing or detailed analysis 
Pseudo recording for accurate MNF measurement and/or for pressure surge detection 
Waterproof and fully submersible to IP68 
Lithium-ion cell battery for >5 year continuous operation. 
 
The RDL600 Series MultiLog Data Logger is available in several different configurations (See Table 1). 
 
Figure 1 shows a typical 4 Channel MultiLog Data Logger. Figure 2 shows a MultiLog Data Logger 
connected to a portable device transferring data from one to the other. 
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Table 1 – RDL600 Series MultiLog Data Logger 

 
MultiLog 

Type 
Series Image Input 

Channel 
options 

Case 
Size 

Manual 
Download 

PSTN 
integral 
modem 

Cellular 
integral 
modem 

Typical 
Cellular 
Power 

Window/Day
 

MultiLog RDL 
600 

 

1 to 4 
channels

Small 
Case 

10 pin 
Local 

Military 
connector 

PSTN SMS/ 
GSM 

0, 2 hour 
Time 

Window 

MultiLog  RDL 
600 

 

1 to 2 
channels

Middle 
Case 

10 pin 
Local 

Military 
connector 

n/a SMS/ 
GSM 

2, 4 hour 
Time 

Window 

MultiLog  RDL 
600 

 

1 to 4 
channels 
--------- 
16 ch 
also 

available 

Large 
Case 

10 pin 
Local 

Military 
connector 

n/a SMS/ 
GSM 

4, 10 hour 
Time 

Window 
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Figure 1 – Typical 4 Channel Radcom MultiLog Data Logger 
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Figure 2 – MultiLog Data Logger connected to Portable Device 
 
 
The MultiLog Data Logger can be ordered using the following matrix: 
 

Table 2 – MultiLog Ordering Matrix 
 
 
 

 
 
 
 
 
 
 
 
 
 

Blank   = No Telemetry 
RCI      = GSM, Office call during 2 Hour Power Window 
RCI  2  = GSM, Office call during 4 Hour Power Window 
RCI  4  = GSM, Office call during 10 Hour Power Window 
RCIP   =  Pager wakeup, call any time 
SMS    =  SMS, (No Power Windows are required) 
 

R D L 6   LF /     /  i/p 1 i/p 2 i/p 3 i/p 4 

1= 1 input 
2= 2 inputs 
3= 3 inputs 
4= 4 inputs 

1= digital pulse input 
2= 0-1 volt input 
3= external pressure 
5= 4-20mA 
6= internal pressure 

1= Portable 
2= PSTN Telemetry 
6= Cellular Telemetry 
     SMS/GSM 
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4 Applications 

Radcom battery powered data loggers and controllers are operating in countries worldwide. They are being 
used in the monitoring and reporting of flow, level and water quality in Potable Water and Environmental 
applications. 
 
The data logger can collect information from a wide variety of sensors, connected to the logger, including 
digital flow, pressure, depth and many others with analogue 4-20mA or Voltage signals. 

4.1 Potable Water Monitoring Applications  

• DMA, General and Domestic Survey Flow Logging 
• Meter Sizing 
• Critical Pressure Monitoring 
• Water Hammer Investigations 
• Reservoir / Tank Depth Monitoring. 

4.2 Potable Water Leakage Reduction Applications 

• Minimum Night Line Flow Logging 
• Step Testing. 

4.3 Environmental Monitoring Applications 

• External Pressure (Depth) Monitoring Systems 
• Ultrasonic Level Sensor Monitoring Systems 
• Open Channel Flow Measurement 
• Chemical and Quality Monitoring. 
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5 MultiLog Installation 

5.1 Positioning 

An initial signal check should be carried out on location to ensure that there is sufficient signal available for 
reliable communications. The logger should then be positioned, if possible, inside a pit/chamber and out of 
the water allowing for easier access. 

 
Figure 3 – Standard Installation of MultiLog with PSTN connection. 

 
Notes 

1) If PSTN is supplied via overhead lines the Radcom recommend the installation of a Lightning arrestor box to 
protect the logger from electric of static shocks. 

2) Suitable earthing provision is required when a Lightning arrestor box is used. 

 

5.2 Earthing 

All telemetry loggers should be earthed to a good ground point. Good ground points that can be used include 
a flowmeter or metal water pipes. If no suitable grounding points are available, it is recommended that an 
earth stake be used. 
 
All data loggers are supplied with an earth wire screwed onto the logger case for connecting to a ground 
point. 
 
Note 

For a data logger housed in an above ground cabinet, the loggers should also be connected to the cabinet ground 
point. 
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5.3 Aerial Positioning 

The antenna should be positioned in an optimal position to gain maximum signal strength. The optimal 
antenna position can be found when installing the logger by using the Signal Strength Test (See Annex D). 
 
Note 

The minimum signal strengths required for successful telemetry communications are as follows:  
 SMS communications signal strength should be at least 6. 
 GSM data communications signal strength should be at least 13. 

 

5.4 Connections 

 
Figure 4 – Common Data Logger Connections 
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Refer to Annex A for detailed information about Pin Configuration and Input Circuitry. 
 
Notes 

1) For sites subject to large pressure surges it is recommended that a snubber is used between the logger and 
pressure point. 

2) For PSTN loggers it is recommended that a surge barrier be fitted between the logger and the telephone line 
connection to prevent any power surges caused by electrical storms or electrical machinery or long telephone 
cables from the exchange causing electrical damage to the logger electronics (see Figure 5 below). 

 

 
 

Figure 5 – Connections Inside PSTN Barrier Box/Lightning Arrestor Box 
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6 Logger Operation 

Each input on the logger has a primary recording channel and secondary (fast sampling) channel, both of 
which are independently programmable. This enables, for example, the primary channel to be used for 
normal recording and reporting purposes and the secondary channel to be used for diagnostic purposes. 
 
For each input the logger can also store data in a pseudo channel, recording the summarized values based 
on the primary and secondary recordings. 

6.1 Analogue Inputs 

The logger samples the analogue channel every 30 seconds or at any recording sample rate, whichever is 
the faster. The data stored in memory for a given channel is the average of all of the samples measured over 
the logging/sampling intervals. 

6.2 Digital Inputs 

The logger can record the digital flow data, either by counting pulses during the sampling period or by 
measuring the pulse interval time (PIT). Data recorded using PIT (Event mode) gives a higher resolution of 
data readings compared to the counting pulse method. The logger can be configured to record in either 
count pulse or event mode (PIT). 
 
It is recommended that event mode should only be used when the pulse rate is less than 2Hz, otherwise the 
logger register will overflow resulting in negative numbers being stored in the memory. 
 
The maximum input frequency for the digital input is limited to 64Hz. The minimum pulse width of the input 
pulses must be more than 8 milliseconds. 
 
Each flow input records data in both directions from bi-direction flowmeters. The logger uses a flow direction 
signal present on the 4-pin flow connector. The flowmeter must be configured to output pulses on the flow 
input, and the status signal to the direction input of the logger. 

Main Recording, Secondary Channels and Pseudo Channels 

The pseudo channel can be configured to store the minimum or maximum readings of the secondary 
recording channel at the same sampling rate as the main recording. 
 
Example: 
Main recording sampling rate = 15 minutes 
Secondary Recording Sample rate = 1 Second 
 
The Secondary Recording Sample rate will take 900 readings during the 15-minute sampling period of the 
main recording. These 900 readings are sorted by highest and lowest values. The highest, lowest or average 
value of any of the 900 readings can be stored in the pseudo channel. 
 
In the case of pressure input it is possible to detect the presence of pressure surges by storing the maximum 
and for digital flow inputs it is possible to give an accurate measurement of Minimum Night Flow by storing 
the minimum. 
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7 RadLog for Windows Software 

“RadLog for Windows” is a software package used with the full range of Radcom portable and telemetry 
linked data loggers. 
 
The software offers icon driven communications, data storage and graphing for the acquisition of data from 
data loggers and controllers. 
 
The software can be used on Server based systems, where the downloaded data is available for multiple 
users across the Local Area Network (LAN) or Wide Area Networks (WAN). Radcom has adopted a 
continuous review and update philosophy based on the feedback from operational users resulting in regular 
updates of the software. 
 
The RadLog for Windows software comprises of four main operational programs: 
 
Setup 
Download/Upload 
View 
Autocall 
 
The Setup program configures the PC hardware, data storage database, file management & access control. 
 
The Download/Upload program configures the logger for the collection and storage of data (direct &/or 
telemetry linked). It can also be used to transfer data from logger to PC. 
 
The View program selects the data to be viewed, displays & manipulates graphs/tabular data and prints &/or 
exports data to other packages. 
 
The Autocall program controls the automatic telemetry communications (if using Telemetry Data loggers) 
 
From a user’s perspective, “RadWin”, the main User program within the RadLog for Windows software, is 
provided to simplify the configuration and interaction of the operational programs. This program provides 
discrete Modules, which are selected when choosing the software using the matrix below. 
 

Table 3 – Radlog for Windows software Order Matrix 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A wizard within the Manual Call module further simplifies the basic configuration settings. The software 
utilizes the use of toolbars and/or drop down menus to simplify the selection of available options. On-Line 
Help and instant Help are readily available. 
 

C = Autocall 
M = Remote Autocall 
N = Administration 
L = Validation 
R = Alarm Receiver 
P = Alarm Programmer 

LOG 

Setup, Download & View 
(Basic RadLog for Windows Package) 

R W32 SDV 1  SIZE = Meter Sizing 
PIPE = Pipe Testing 
PRV = PRV Controllers 
PER = Performance Graphing 
 

 

1 User Licence 
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The typical applications of RadLog for Windows are: 
 

• Logger setup & data download 
• Data Analysis 
• GIS interface 

 
The Logger Setup & Data Download application is ideal for setting up and downloading data from any 
Radcom data logger on site using a Laptop PC or similar portable device, in the office using a Desktop PC, 
or via PSTN or GSM telemetry links. 
 
The Data Analysis application provides a simple to use extensive graphing package for data analysis with 
windowing and zooming functionality. Data can also be examined in table format on screen, or exported into 
other packages. 
 
The GIS Interface application can be linked to proprietary GIS Graphical Information Systems, or can be 
used with Radcom’s Easy GIS software. 
 
The RadLog for Windows software is available on CD, Web download or E-Mail and can be ordered using 
the matrix shown in Table 3. 
 
The Minimum Hardware Requirements for installing the software are: 
 
• IBM PC or compatible 400MHz or greater 
• Hard Disk   20 Mb 
• CD Drive   8 x ROM 
• Environment  Microsoft Windows 3.1, 3.11 (32 bit Software), ’95, ’98   

NT4, Windows 2000, Me, XP 
• PC Comms Port  RS 232 “9 pin D” Serial Port. 
 
 
Certain communications procedures supported by the software require the following items: 
 
• Radcom Data logger with suitable PC connection 
• Hayes compatible Modem for telephone or GSM Cellular communications 
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8 How to Install the Radlog for Windows Software 

RadLog for Windows is supplied with an installation program that installs the Setup, Download/Upload and 
View programs. The other available modules can be installed if required and/or purchased from the main 
screen. 
 
The flow chart below highlights the procedures required for installing the RadLog for Windows software. 
 

 
 

Figure 6 – Software Installation Flow Chart 
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8.1 Initial Installation 

For initial installation, use RadWin installer software to install “RadWin”, “Autocall” and “Manual Wizard” 
modules. These two modules will be enough to start using RadWin software with the data loggers. Other 
software modules may be installed as and when required. 
 
To install the RadLog for Windows software, proceed as follows: 
 
1. Confirm the License Agreement – By removing the packaging or starting the installation you are 

accepting the terms of the agreement. 
2. Insert the CD into drive and wait for the RadWin installer software screen. 
3. Select the module to install (“RadWin”). 
4. Specify the destination directory – C:\RadWin is the default destination directory, but a new path can be 

specified if required. 
5. Enter the Registration Number – Contact Radcom at the address given on the software and quote your 

Serial and Installation Number. You will be given a Registration Number unique to the computer running 
the software. 

6. If other modules are supplied on your CD, click on the relevant icon to download. 

8.2 Initial Configuration 

As an initial activity, the associated Database Path and Communications Port configuration must be carried 
out as described below. 
 
It is important that the software is correctly configured before running the program for the first time. This 
ensures that the Database Path and Communication Ports are correct, as well as establishing the required 
file structure. 
 
After the installation of the RadWin Software and required modules have been successfully completed, run 
the Setup program and select System Configuration from the drop down menu or icon. 

Database Path Configuration 
The Database Path configuration options are displayed on the System tab of the System Configuration 
screen (see Figure 7). 
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Figure 7 – System Configuration Screen 
 
 
The database path specifies where the logger database will be stored, and where the software will look to 
find its data files. Multiple databases may be created on a system by specifying different paths in the 
database path entry field. 
 
If the database specified exists, it will be used throughout the software; otherwise a new database will be 
created. 
 
To amend or add a new Database path click on the Advanced button to display the Advanced 
Configuration screen, and input the path into the New Database Path field (see Figure 8). 
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Figure 8 – Advanced Configuration screen 
 

Communications Port Configuration 

The Communication Port configuration options are found under the Manual Call tab of the System 
Configuration screen (see Figure 9). 
 
This option allows the user to select the communication ports and baud rate for manually communicating 
with the loggers connected directly to the PC, or via a modem.  
 
If only one Serial Port is available on the PC for both local and telemetry communications, the same COM 
port can be selected in system configuration, connecting a local download lead, or modem, to that same port 
as and when required. 
 
For MultiLog Select:- 
 
   Direct RS232 Port baud rate = 19,200 baud   MultiLog local download 
   Land Line Modem  baud rate =   2,400 baud MultiLog PSTN Telemetry 
   Cellular Modem  baud rate =   9,600 baud MultiLog GSM /SMS Telemetry 

  Paknet Modem  baud rate =   4,800 baud MultiLog Paknet Telemetry 
 
 
 
 
 
 
 



 
 

 
USER MANUAL - MULTILOG 

Page 17 
 
 

 
 
 
 
 
 

 
 

Figure 9 – Communication Port configuration 
 
 
The Communication Port configuration options for “Autocall” module are carried out in the same way as 
above. 
 
Note 

SMS Modem Port baud rate = 9,600 baud 
 
After completing the Database Path and Communication Port configurations, click on the OK button at the 
bottom of the System Configuration screen.  
 
A Create Database Path pop-up screen will appear (see Figure 10). 
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Figure 10 – Create Database Path screen 
 
 
Select the required format for the Zone and Location from the Database Identity Format field drop-down 
menu. 
 
If the Database Path shown is correct, click the OK button to complete the initial configuration. The software 
is now ready for configuring the data logger before installation. 
 
The more experienced operator may configure the logger manually, whilst an operator who is new to the 
software should use the available software modules. 
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9 Communicating With The MultiLog Data logger 

A selection of communication options, suitable for automatically or manually downloading data from remote 
Data Loggers and returning the data back to the office PC or server, are available. 
 
Communicationscommands can be sent and received by the data logger by connecting directly with a PC or 
Portable device or via GSM or SMS telemetry using a mobile phone or modem connected to a PC. 
 
The data logger must be configured, using the RadWin software, to automatically send and receive data to 
the WorkstationPC/Server when using telemetry options. 

10 How To Configure The MultiLog GSM or SMS Data Logger Using 
The Manual Call Wizard 

The Manual Call Wizard will help to configure the Logger Identity, channel configuration, modem call-out 
numbers and times, and the Power Window settings. The other available modules, if installed, can be used 
to aid in the configuration of the Alarm, AutoCall and Data Generator features. 
 
The flow chart below highlights the procedures for configuring a data logger using the Manual call Wizard. 
 

 
 

Figure 11 – Data Logger Configuration Flow Chart 
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The following procedures show how to configure a MultiLog GSM/SMS Data Logger using the Manual Call 
Wizard. 
 
Select the Radcom Manual Call icon from the Windows Start menu (see Figure 12). 
 

 
 

Figure 12 – Windows Start Menu 
 
 
From the Manual Call Wizard screen select the Configure Logger Wizard using the icon or drop-down 
menu under the Options tab. 
 
Follow the wizard and proceed after each option by clicking on the Next button. 
Note 

All of the configuration information can be seen on the left side of the screen of the Configuration Summary box of 
the Configure Logger Wizard screen (See Figure 13). 
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Figure 13 – Configure Logger Wizard 
 

Logger Type 
What type of Logger do you wish to configure? 
 
At the Logger Type field, select the MultiLog Flash GSM/SMS from the drop-down menu. 
 

Connection Type 
How is the logger currently connected to the computer? 
 
At the Connection Type field, select the appropriate connection type from the drop-down menu (Direct, 
Modem or Bluetooth). 
 

Baud Rate 
What baud rate should be used to talk to the logger? Direct connection is generally 19200,Telephone line 
logger Modem connection is 2400, GSM connection is 9600, and Paknet connection is 4800. 
 
At the Baud Rate field, select the appropriate baud rate from the drop-down menu options  
 

Analyse Logger 
The logger parameters will now be downloaded. If the download fails, check the logger is connected to the 
computer as specified and the connection configuration is correct. 
 
Click the Next button for the software to download the logger parameters. 
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Logger Identity (Zone and Location) 
The Zone is the first part of the logger identity, and is used for grouping loggers within the software. The 
Location is the second part of the logger identity, and identifies a logger within a Zone. 
 
In the Zone Identity, Location Identity and Name fields, enter the logger identities and names, or click the 
Select button to select them from an existing database (see Figure 14). 
 
 

 
 

Figure 14 – Logger Zone and Location Identity Screen 
 

Connection Type 
How will the logger be downloaded when it has been installed? 
 
At the Connection Type field, select the SMS modem connection type from the drop-down menu options 
(Direct, Modem, SMS modem or Bluetooth). 
 

Telephone Number 
Enter the full telephone number (including international dialling code) of the logger; this is normally displayed 
on the front of the logger. 
 
In the Telephone Number field enter the telephone number of the logger (i.e.+441234123456). 
 

Channel 01 Configuration 
Enable the channel, if required, and set the logging mode for digital channels. 
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Figure 15 – Channel 01 Configuration Screen 
 
Click in the Enable field to activate the channel (see Figure 15). 
 
In the Transducer field, select the Transducer Type from the drop-down menu. 
 
Click the Configure button to update the channel information. 
 
Select the Sensor type to be connected to Channel 01 from the drop-down menu in the Sensor Type field, 
(see Figure 16). 
 

 
 

Figure 16 – Transducer Configuration Screen 
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Select the required Transducer type from the drop-down menu in the Select Transducer field. 
 
The name, calibration and offset values can be entered into the Enter/Edit Information fields. Click on the 
Add to the Select Transducer List button to add the new transducer information to the database. 
 

Channel 02 Configuration 
Enable the channel if required and set the logging mode for digital channels. 
Note 

SMS WARNING - Logging modes other than 'Standard' will require the transducer to be configured with the 
units per pulse multiplied by n, where n is 'Every nth Pulse'. 

 
 

 
 

Figure 17 – Channel 02 Configuration Screen 
 
Click in the Enable field to activate the channel (see Figure 17). 
 
Select the required power options from the drop-down menu in the Power Options field, (Power Save, 
Continuous Power or No Power). 
 
From the Count field drop-down menu, select the required option (Count or Event). 
 
Note 

Presently SMS loggers only support Count mode. 
 
From the Standard field drop-down menu, select the required option (Standard or Every x nd/th pulse). 
 
Select the Transducer Type from the Transducer field drop-down menu (Digital (Flow)). 
 
Click on the Configure button to update the channel information. 
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Select the Sensor type to be connected to Channel 02 from the drop-down menu in the Sensor Type field. 
 
Select the required Transducer type from the drop-down menu in the Select Transducer field. 
 
The name, calibration and offset values can be entered into the Enter/Edit Information fields. Click on the 
Add to the Select Transducer List button to add the new transducer information to the database. 
 

GSM Callout Numbers 
GSM Callout Numbers are the telephone numbers the logger may dial to send data. Only one number is 
usually required, with a maximum of four numbers allowed. These numbers will be the telephone numbers of 
the modems being used by the Autocall module 
 
A telephone number can be entered here, or selected from a list of telephone numbers that exist in the 
Database Telephone Directory. 
 
 

 
 

Figure 18 – GSM Callout Number Screen 
 
 
Highlight Line 01 and click on the Edit Selected List Item button (see Figure 18). 

 
 

 
 

Figure 19 – GSM Telephone Number Screen 
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Enter the telephone number in the Telephone Number field, using international format, or click on the 
Select button to choose a telephone number from the database Telephone Directory (See Figure 19). 
 
To add more GSM telephone numbers, highlight the next line and follow the above procedures. 

GSM Callout Times 
The GSM Callout times specify when the logger will call or send data via SMS to the GSM Callout Numbers 
specified. Up to eight callout times can be specified. 
 

 
 

Figure 20 – GSM Callout Times Screen 
 
 
Highlight Line 01 and click on the Edit Selected List Item button (see Figure 20). 
 
 

 
 

Figure 21 – Call-Out Time Configuration Screen 
 
 
Click into the Enable Call field to enable the Call Time. In the Call Time and Call Number fields, select the 
time (hours & minutes) that the logger is to call, and the telephone number to be called (See Figure 21). 
 
To add more Callout Times, highlight the next line and follow the above procedures. 
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GSM Power Windows 
The GSM Power Window specifies the time periods when the GSM module in the logger is turned on. During 
these periods the logger will answer incoming calls and/or receive SMS messages for data download or 
upload. Up to eight power windows are allowed. 
 
 

 
 

Figure 22 – GSM Power Window Screen 
 
 
Highlight Line 01 and click the Edit Selected List Item button (see Figure 22). 
 
 

 
 

Figure 23 – Power Window configuration screen 
 
 
Click into the Enable Power Window field to enable the Power Window. In the Window Start Time and 
Window End Time fields, select the time (hours & minutes) the logger is to ‘Power Up’ and ‘Power Down’ 
(see Figure 23). 
 
To add more Power Windows, highlight the next line and follow the above procedures. 
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Upload Logger 
The logger will be uploaded with the entered parameters and will start data logging. The information will be 
entered into the database under the entered zone/location identity. 
 
Click on the Next button to download the logger parameters. 

Finished 
The logger parameters have been uploaded and data logging has started. The location information has been 
entered in the database. 
 
Click the Finish button to exit the Configure Logger Wizard. 
 
Select Exit from the File drop-down menu. 
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11 MultiLog Configuration Options 

11.1 Manual Data Download 

The flow chart below highlights the procedures for manual logger data download. 
 

 
 

Figure 24 – Manual Data Download Flow Chart 
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11.2 Requesting data from Data Logger to Receive Data Via SMS 

It is possible to request data via SMS or via data connection. The GSM modem inside the logger must be 
switched ON at the time of requesting data. To request data, proceed as follows: 
 
Select the Radcom Autocall icon from the Windows Start menu. 
 
Select Call List from the Options drop-down menu. 
 
Select the SMS Modem Connection tab on the Autocall List screen to display the loggers in the list (See 
Figure 25). 
 
Click and highlight the appropriate logger to select it from the list. 
 
Click the Selected Loggers button under the Force Download heading. 
 
Click the Download Type button on the Force Download Completion screen and click and highlight the 
appropriate selection. 
 
Click on the OK button to start. 
 
 

 
 
 

Figure 25 – AutoCall List screen 
 
The software will dial the data number and send the relevant messages requesting data. 
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11.3 Requesting data from Data Logger Via GSM 

It is possible to request data via GSM/PSTN data connection. The GSM modem inside the logger must be 
switched ON at the time of requesting data. The SIMM card inside the logger should also be enabled for 
Data connection. To request data, proceed as follows: 
 
The modem will be switched ON during a power window, or while external power is plugged in. It will switch 
ON for 30-minutes after plugging a 10-pin commissioning connector into the logger for at least 5 seconds. 
 
Select the Setup 32 icon from the Windows Start menu. 
 
Select Update Zone from the File drop-down menu or by clicking the Update Zone icon on the Radcom 
Setup screen. 
 
Click on and highlight the appropriate Location Identity and click the Edit button on the Location Select 
screen (see Figure 26). 
 
 

 
 

Figure 26 – Location Select Screen 
 
 
Select the Logger tab from the Location Configuration screen (see Figure 27). 
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Figure 27 – Logger Tab, Location Configuration Screen 
 
 
Select the logger type as MultiLog GSM/SMS from the drop-down menu in the Type field under the Identity 
heading. 
 
Check that the Baud rate is set to 9600 in the Baud field. 
 
Check that the Connection type is set to Modem under the Connection heading. 
 
Enter the telephone number of the logger into the Number field. 
 
Select the Autocall tab (See Figure 28). 
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Figure 28 – Autocall Tab, Location Configuration Screen 
 
Click in the Enable Autocall box under the Call Out Options heading to enable Autocall. 
 
Enter the time to call the logger (hours & minutes) in the Start Time/Date field to coincide with the Power 
Window. 
 
Enter the Call Interval times into the Call Intervals fields, entering the frequency of calls in the first box and 
the periodicity of the calls from the drop-down menu in the second box. 
 
Click the Save button to store the settings. 
 
Run the Autocall module and wait for the software to configure the modem. 
 
The Autocall will automatically call the logger at the predetermined time and intervals set above. 
 
 
It is possible to force a call to the logger as follows: 
 
Display the call list of all loggers 
Select the Modem connection page to display the logger in the list 
Select the logger from the list and click to highlight 
Press the Selected Logger button followed by the OK button. 
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11.4 Communicating with a “SMS” Data Logger using a Mobile Phone 

It is possible to send messages and request data from the data logger using a mobile telephone. 
To send a SMS message to the Logger from a mobile telephone, proceed as follows: 
Make sure the GSM modem inside the logger is switched ON 
 
The modem will be switched ON during a power window or while external power is plugged in. It will switch 
ON for 15-minutes after plugging a 10-pin commissioning connector into the logger for at least 5 seconds. 
 
Example: 
 
Use the mobile phone to send the following SMS text message to the logger :    TTTT# 
 
The logger will respond with a reply message within 2-minutes. 
The message will be  CSQ xx 
   Ch1 yyyyy.y 
   Ch2 zzzzz.z 
 
Where xx = signal strength. This must be between 08 and 30. 
yyyyy.y = Channel 1 reading in metres 
zzzzz.z = Channel 2 reading in Litres/second 
Assuming Channel 1 is pressure and Channel 2 is flow 
 
The logger will ONLY check for incoming SMS messages during the pre-configured Power Windows. 
 

SMS Message Command Descriptions 

The characters that compose the SMS messages are case sensitive. Each text message sent to the logger 
is to be terminated with the # (hash) character. A summary of the SMS text messages serviced by the logger 
can be found in Table 4 below.  
 

Table 4 – SMS Text Message Command Descriptions 
 

Text Message Description 
TTTT Signal Strength & Latest data values in raw units 
Stat Latest data values in SI units 
SigN Signal Strength test 
config Logger configuration in database 
MinN Minimum flow/pressure for last “n” days 
MaxN Maximum flow/pressure for last “n” days 
SumN Data summary for last “n” days 
Win First two enabled SMS parameters 
Totl Total volume (meter reading) 

for all flow channels 
 
A complete guide to the SMS Message Descriptions can be found in Annex B. 
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12 Data Collection Methods 

The data collated and stored in the data logger can be transferred directly to the Workstation PC via a 
portable device, or by Data logger/Office initiated telemetry. 

12.1 Local Data Collection Methods 

The logger must be connected directly to a Portable device to receive the stored data from the data logger. 
Local Data Collections can be made using the following portable devices: 
 

• Laptop/PC 
• RadLink hand held computer 
• Psion Workabout hand held computer 
• PDA hand held computer. 

 
After the data has been transferred from the logger to the portable device, the operator returns to the office 
and transfers the data from the portable device to the Workstation PC/Server. 
 

12.2 Logger Initiated Telemetry Methods 

The following methods can be used to transfer data from a logger to a Workstation PC/Server via 
communications networks: 
 

• SMS 
• GSM 
• Email. 

 
Logger Initiated SMS Telemetry 
The SMS text messages are received by the Cellular Modem, connected to the Workstation PC/Server. SMS 
messages may queue up on the cellular network, finally received when the office modem is not busy. 
Radcom's special data compression techniques enable two channels of data to be sent within a single daily 
SMS message, for 15-minute sample rate recordings. 
 
Logger Initiated GSM Telemetry 
The GSM call is received on the Cellular or PSTN Modem connected to the Workstation PC/Server. The 
receiving PC/Server can have several modems connected simultaneously. A single PC/Server can then 
accommodate hundreds of loggers and download data each night. Radcom recommend allocating at least 2 
minutes per logger for each data download into the same office modem. 
 
Logger Initiated Email Telemetry 
The Email is received directly from a Data logger via any Outlook client configured on a Workstation 
PC/Server. Alternatively, the RadWin software can configure the Workstation PC/Server to collect Email 
directly from an Email Exchange server. This system does not require any Radcom dedicated modem in the 
office. 
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12.3 Office Initiated Telemetry Methods 

The following methods enable data transfer between a logger and the Workstation PC/Server, at the request 
of the PC/server: 
 

• PSTN 
• GSM. 

 
The Workstation PC/Server initiates a data call to a PSTN or GSM logger, via either a PSTN or GSM 
modem attached to the PC/Server. The logger then returns the data during the real time call. Further 
loggers can be downloaded from a scheduled calling list using RadWin Autocall software. In some countries 
GSM to GSM communications (and using the same network provider) may minimise call costs. 
 
It is possible to contact a GSM logger using a PSTN modem connected to the Office PC/Server, or a PSTN 
logger from a GSM modem on the Office PC/Server. 
 

Advantages of Office Initiated Telemetry 
Office initiated Telemetry has the following advantages over Logger initiated telemetry: 
 
The server is in control - Time settings within the loggers are less critical. 
Greater numbers of loggers can be downloaded in less time. 
Any missing data from earlier days when the logger could not be contacted will be automatically recovered 
during the next successful call from the office. 
The Logger clocks can be synchronised to the Server's clock. 
Real time handshaking between server and logger provides greater confidence when resetting logger 
parameters remotely. 
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13 Alarms 

The logger has the capability of sending alarms to the Workstation PC/Server to alert the operator to 
readings that are higher or lower than a pre-configured value. The alarms are initiated from the logger and 
sent to the Workstation PC/Server and can be accessed at that point, or can be re-directed to a mobile 
phone, e-mail or accessed by another PC. 
 
Data loggers are configured to send alarms by using the Radcom Alarm Programmer module within the 
Radlog for Windows Software. 
 
The methods in which the alarms are received and re-directed are configured using the Radcom Alarm 
Receiver module within the software. 
 
It is recommended that data be collected from the site for a few weeks before configuring alarms into the 
logger. This will enable the operator to work out sensible alarm parameters. 

13.1 Programming Level Alarm 

To configure a data logger with the Radcom Alarm Programmer module, proceed as follows: 
 
Select the Radcall Alarm Programmer icon from the Windows Start menu. 
 
Select Alarm Parameters from the View drop-down menu. 
 
Select the Levels tab in the Alarm Parameters screen (see Figure 29). 
 
 

 
 

Figure 29 – Level tab, Alarm Parameters Screen 
 
 
Double click on the required channel to amend the alarm values. 
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Figure 30 – Alarm Level Update Screen 
 
 
Input the alarm level values required into the Upper, Lower and Minimum Night fields on the Alarm Level 
Update screen (see Figure 30) using the units displayed in Figure 29. 
 
Click on the OK button. 
 
Select the Tel Numbers tab on the Alarm Parameters screen (see Figure 31). 
 

 
 

Figure 31 – Tel Numbers tab, Alarm Parameters Screen 
 
Double click on the required Tel Number position to amend the telephone number to which the logger will 
send the alarm. Up to 16 telephone numbers can be selected, (only 4 tel numbers for SMS loggers). 
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Figure 32 – Telephone Number Update Screen 
 
Enter the telephone number of the modem receiving the alarms into the Number field in the Telephone 
Number Update screen (see Figure 32) or click Select to choose a telephone number from the Database 
Telephone Directory. 
Note 
A maximum of 12 digits are allowed for telephone numbers. Use local number format if necessary. 
 
Click on the OK button. 
 
Select the Comments tab in the Alarm Parameters screen (see Figure 33). 
 
 

 
 

Figure 33 – Comments Tab, Alarm Parameters Screen 
 
 
Enter up to 16 characters of text into the Short field. The text typed into this field is used by the logger when 
reporting an alarm. 
 
The Long field is for information only and can be used to describe the location of the logger. 
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13.2 Programming Profile Alarm 

 
 

Figure 34 – Profile Tab, Alarm Parameters Screen 
 
 
It is possible to enter 24 hourly values, which define a diurnal profile. The logger will interpolate between 
consecutive values to compute the 15-minute profile. 
 
Note 

The profile tab will only appear on the Alarm Parameter screen if the Alarm Programmer has already 
communicated with a logger supporting Profile Alarms (see Figure 34). 

 
To amend the profile, proceed as follows: 
 
Select the required Channel from the drop-down menu. 
 
Select a Day of the Week from the drop-down menu. 
 
Input the required values into the Lower and Upper fields to define the profile for the above selection. It is 
possible to import an existing ASCII file containing the hourly values to create a profile. 
 
 
The Copy button allows the user to copy the displayed profile to other days of the week. 
 
Click the Copy button to move to the Copy Profile screen (see Figure 35 below). 
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Figure 35 – Copy Profile Screen 
 
Click in to the required Days of the Week fields to select them for copying. 
 
Click on the OK button. 
 
 
Select the Alarm Configuration screen from View drop-down menu. 
 
 

 
 

Figure 36 – Alarm Configuration Screen 
 
 
Double click on the required Alarm condition in the Alarm Configuration screen to edit the Alarm details 
(see Figure 36). Up to 16 separate alarm conditions can be configured. 
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Figure 37 – Update Alarm Configuration Screen 
 
 
Click in the Status field on the Update Alarm Configuration screen to enable the Alarm (see Figure 37). 
 
Choose the required channel number from the Channel drop-down menu. 
 
Select the required alarm type from the Type drop-down menu. 
 
Select the telephone number to call from the Telephone drop-down menu. 
 
Select the persistence and occurrences from the Persistence and Occurrences drop-down menus. 
 
Click on the OK button. 
 
Select Upload from the Communications drop-down menu to open the Upload Configuration screen (see 
Figure 38). 
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Figure 38 – Upload Configuration Screen 
 
Select the logger type as MultiLog Flash GSM/SMS from the Type drop-down menu. 
 
Select the Baud Rate to the required rate using the Baud drop-down menu. 
 
Select the required Connection type from the Connection drop-down menu. 
 
Click on the OK button. 
 
 

 
 

Figure 39 – Upload Options Screen 
 
 
Click in the required Options boxes on the Upload Options screen (see Figure 39) to select the option for 
Uploading to the logger. Select the Alarm Profiles from the drop-down menu as required. 
 
Click on the OK button. 
 
The Uploading screen should appear to confirm that the Alarm conditions are being transferred to the logger 
(see Figure 40). 
 
 

 
 

Figure 40 – Uploading Information Screen 
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13.3 Receiving and Acknowledging the Alarms 

The RadWin software must be configured to receive, acknowledge and re-direct alarms. The Radcom Alarm 
Receiver module allows the operator to configure the software to enable these functions. 
 
To configure the software, proceed as follows: 
 
Select the Radcall Alarm Receiver icon from the Windows Start menu. 
 
Note 

Make sure the Alarm Receiver communications ports are set correctly. The settings can be checked in the Alarm 
Receiver Port tab under the System Configuration menu (see Figure 41). 

 
 

 
 

Figure 41 – Alarm Receiver Ports Screen 
 
 
All alarms from SMS loggers are reported via the “Autocall” module receiving/sending SMS messages via. 
the “SMS Modem” connection. The “Autocall” module must also be running to receive alarms from 
GSM/SMS data loggers. 
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Figure 42 – Radcom Alarm Receiver screen without alarms 
 
If no alarms have been received the Radcom Alarm Receiver screen will be blank (See Figure 42). 
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Figure 43 – Radcom Alarm Receiver Screen with Alarms 
 
If any alarms have been received the Radcom Alarm Receiver screen will have the Alarms listed (see Figure 
43). 
 
To acknowledge the alarms, highlight the alarms by clicking on the appropriate line(s) and select 
Acknowledge Selected Alarms from the Options drop-down menu. 
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Figure 44 – Acknowledge Selected Alarms Confirmation Screen 
 
Click the OK button to confirm the acknowledgment of the selected alarms (see Figure 44). 
 

Alarms Initiated from Logger Types 

The following logger types can alarm out to a Workstation/PC: 
 
PSTN – Data connection 
SMS – Text messages 
GSM – Data Connection 
E-Mail - Internet 
 

PSTN Alarms 
Data Loggers fitted with a PSTN modem, connected to a telephone line, are only capable of sending Alarms 
by PSTN. This alarm can be sent to a different telephone number from that of the main data download PC. 
The only way of receiving such PSTN alarms is via a Workstation PC/Server. Radcom recommend that a 
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separate PSTN modem is setup for receiving alarms to avoid conflicts if alarms are triggered whilst data 
downloads are active with other loggers. 
 

SMS Alarms 
Data Loggers set up for sending data by SMS are only capable of sending alarms by SMS. This alarm can 
be sent to a different telephone number from that of the main data download PC. SMS Alarms can also be 
sent directly from the Radcom SMS logger to any mobile phone. 
 

GSM Alarms 
Data Loggers set up for sending data by GSM are only capable of sending alarms by GSM. This alarm can 
be sent to a different telephone number from that of the main data download PC. The only way of receiving 
such GSM Alarms is via a Workstation PC/Server. Radcom recommend that a separate cellular or PSTN 
modem is configured for receiving alarms to avoid conflicts if alarms are triggered whilst data downloads are 
active with other loggers. 
 

E-MAIL Alarms 
Data Loggers set up for sending download data by E-mail are capable of sending alarms by E-mail to any 
valid e-mail address or by sending an SMS message to a mobile phone or Workstation PC/Server. 
 
Notes 

1) It is recommended that all alarms from loggers are directed to a PC/Server to collate all Alarm messages, and if 
necessary those Alarm messages can be re-transmitted by RadWin software via SMS to a Mobile phone or via 
email to any valid email address for investigation or action. 

2) Alarm persistence parameters can be setup within the Radcom data logger. Alarms can be sent immediately 
upon reaching a pre-set limit. Alternatively, the Alarm can be delayed until the abnormal condition has been 
present for a pre-set time. 

 

Alarms Re-Transmitted from PC/Server 

The RadWin software can forward the received alarms to a mobile telephone or e-mail address: 
 

SMS Re-Transmitted Alarms 
The Alarm Receiver can forward any incoming alarm from PSTN, SMS, GSM or E-mail loggers by sending 
an SMS Alarm message to any Mobile phone. For this to be possible the Workstation PC/Server requires a 
SMS modem. 
 

E-MAIL Re-Transmitted Alarms 
The Alarm Receiver module can, alternatively, forward any incoming alarm from PSTN, SMS, GSM or E-mail 
loggers by sending an E-mail Alarm message to any valid e-mail address for investigation or action. For this 
to be possible the PC/Server will require connection to an operational e-mail account. 
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14 Trouble Shooting 

The following table contains the solutions to general problems that may occur during the installation, 
configuration and operation of the data logger. 
 
Please contact the Radcom Help Desk for assistance in fixing any problems that are not covered in this 
section. 
 
Problem Solution 
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
 

Table 5 – Troubleshooting Guide 
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15 Diagnostics & Maintenance 

15.1 Built in Test Facility 

The data logger has a built-in test facility to carry out the following automatic checks on power up: 
 
Internal RAM 
Comparing the Real Time Clock (RTC) with the micro-controller crystal clock 
Communications with the RTC chip 
Communications with the A/D converter 
Watch dog timer. 

15.2 Battery Usage 

The data logger constantly monitors the following parameters of battery usage: 
 
Battery life remaining in percent 
Average battery voltage and usage recorded every 2 days. Usage data can be downloaded and viewed 
graphically 
Watchdog occurrence and details. 

15.3 Audit Trail 

The data logger keeps an audit trail of any alteration of parameters for each of the following: 
 
Details of the last N calibration, including the calibrators’ initials, the calibration type, the range and the dates 
etc 
Header parameters changed for the Last N recordings. (E.g., start time, stop time, identification, sample rate 
etc.) 
The last N time/date of communications command, communication duration, data length, start address, 
recording number and communication re-tries. 
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Annex A  – Connection Details 

 
A1. Cables For Use With The MultiLog Data Loggers 
 

Table A 1 – Cable Details For MultiLog Data logger 
 

Logger Type  Part Number Cable description  
MultiLog 
Sentry 
SentinelPlus 
Pegasus to PC lead 

COM AE 
 

10 Pin Military plug to 9 pin D plug 

RadNet to MultiLog 
lead  

COM EE 10 Pin Military plug to 10 Pin Military plug 

RadLink to PC lead  COM AA 9 pin D plug to 9 pin D plug 

 
 
A2. Pin Configuration For MultiLog To PC Cable 
 

Communications Connector Details 

 
Table A 2 – 10 Pin Connector Type 62GB57A-12-10 

 
Pin No. Title Description 

A Audit/Modem Detect Audit enable for GSM/SMS loggers 
B Reserved  
C Batt -VE Battery connection 
D V+ External power input (9 to 12 volts) 
E Reset External reset 
F GND (0V) Ground (0 volts) 
G NC Not used 
H NC Not used 
J RXD RS232 input 
K TXD RS232 output 
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External Pressure Input 
 

Table A 3 – 6 Pin Connector Type 62GB57A-10-6 
 

Pin No. Title Description 
A V+ (5 volt) Stabilised power supply 
B +VE signal Positive input signal 
C GND (0V) Ground (0 volts) 
D -VE signal Negative input signal 
E Screen Screen to chassis 
F   

 
 

.
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Figure A 1 – External Pressure Sensor Input Circuit 
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Flow Input 
 

Table A 4 – 4 Pin Connector Type 62GB57A-10-4 
 

Pin No. Title Description                        
A V+ Switched Power supply        
B Flow Flow input signal (pulses)      
C GND (0V) Ground (0 volts)                   
D Direction Direction input signal            

0V = -VE direction 
 
 

1

2

3

.

.

VSS

VDD

Maximum frequency 64Hz
Minimum pulse width 8mS

Logger
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Figure A 2 – Digital Flow Input Circuit 
 
 
Typical colour coding used by Radcom loggers flow input cables: 
 
Pin A -  Red 
Pin B - Blue 
Pin C -  Green 
Pin D - Yellow. 
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MilliAmp Input 
 

Table A 5 – Pin Connector Type 62GB57A-10-4 
 

Pin No. Title Description 
A   
B +VE signal Positive mA input signal 
C   
D -VE signal Negative mA input signal 

 
 

.

Logger
 mA
input 
ciruit

.

+

-

GND

.

.

B

VDD

D

4-20mA
transmitter

 
 

Figure A 3 – MilliAmp Input Circuit 
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Annex B  – SMS Message Command Descriptions 

B1. SMS Message Descriptions 
 
The Data logger can receive two types of messages. These are either Installation and Commissioning 
messages or Status messages. 
 
During Installation & Commissioning a special 10-pin military connector is plugged into the 10-pin connector 
fitted on the logger, switching ON the GSM modem. If the connector is plugged in for more than five seconds 
the logger will switch ON power to the GSM modem and listen for incoming messages. After the connector is 
removed the logger starts an half hour time-out counter. The power to the GSM modem is switched OFF 
after the half hour timer has expired. 
 

Installation & Commissioning Messages 

“Stat#” Latest data values in SI units 
When the logger receives the SMS text message “Stat#” from a telephone number it replies with the 
following message. 
 

Table B 1 – Stat# SMS Text Message 
 

Message Description 
Stat Original command text without # 
V 01.00 Firmware version in Logger. 
+CSQ: nn Signal strength nn (nn = 6 to 30) 
cccccc Message counter (Total no. Of messages sent by logger) 
LBat.=PP.P x% % Logger battery Remaining (Not GSM battery) 
ZZZZLLL Zone/Location details  
RDL634LF/3131 Logger part number describing input configuration. 
Ch1 0056.8 Channel 1 - Latest Pressure reading in metres  
P0.100 P = Pressure calibration value 
Ch2 015620 Channel 2 - Latest Flow reading in litres/hour 
F010.0 F = Flow Litres/pulse 
Ch3 0056.8 Channel 3 - Latest Pressure reading in metres  
P0.100 P = Pressure calibration value 
Ch4 151200 Channel 4 - Latest Flow reading in litre/hour 
F100.0 F = Flow Litres/pulse 
High Street Test Comment in logger 
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“SigN#” Signal Strength test 
When the logger receives the SMS text message “SigN#” from a telephone number it replies with the 
following message. This message should be sent after the logger is installed in the final position in the meter 
pit and all pit covers are in place. 
 

Table B 2 – SigN# SMS Text Message 
 

Message Description 
SigN Original command text without # 
V 01.00 Firmware version in Logger. 
+CSQ nn Signal strength nn (nn = 6 to 30) 
cccccc Message counter (Total no. Of messages sent by logger) 
CSQ Min = nn Minimum GSM Signal strength level  
CSQ Max = nn Maximum GSM Signal strength level  
CSQ Avr = nn Average GSM Signal strength level  
CSQ Stdv = nn.n Standard Deviation of GSM Signal strength level  
ZZZZLLL Zone/Location details  
High Street Test Comment in logger 

 
The logger starts logging the GSM signal strength after receipt of this message. The logger measures and 
records the GSM signal every 15 seconds for “N” minutes to calculate the Minimum, Maximum, Average and 
Standard Deviation of signal levels. It will take at least n minutes before the logger replies to the above 
message. The range for n is from 1 to 9 minutes. 
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“Config#” Logger configuration in Database 
Before sending this message to the logger, it is important that the logger has been configured with a 
telephone number in call number position 01. The Autocall module should be running, listening for SMS 
messages on the configured telephone number. 
 
When the logger receives the SMS text message “Config#” from a mobile telephone number, it sends the 
following message to the first telephone number (office PC) in the callout list. 
 

Table B 3 – Config# SMS Text Message 
 

Message Description 
Config Original command text without # 
+44776411111 Telephone number of original caller 
V 01.00 Firmware version in Logger. 
+CSQ: nn Signal strength nn (nn = 6 to 30) 
cccccc Message counter (Total no. Of messages sent by logger) 
ZZZZLLL Zone/Location details  
RDL634LF/3131 Logger part number describing input configuration. 
P000.1 Channel 1 – calibration value (P = Pressure) 
F010.0 Channel 2 – Litres/pulse (F = Flow) 
P000.1 Channel 3 - calibration value (P = Pressure) 
F100.0 Channel 4 - Litres/pulse (F = Flow) 
Sno 00123 Serial number of data logger 
Dom 03-04-04 Date of manufacture of data logger (dd-mm-yy) 
High Street Test Comment in logger 

 
Upon receipt of the above message, the computer running Autocall will create a new zone/location in the 
Database, as per details above, provided this zone/location does not already exist or the logger telephone 
number is not used by another zone/location already in the existing database. 
 
If the zone/location has been created successfully in the database, Autocall will send the following message 
to the originator of the “Config” message. 
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Table B 4 – Zone Created Successful SMS Text Message 

 
Message Description 
CREATED  
+44776411111 Telephone number of original caller 
V 01.00 Firmware version in Logger. 
+CSQ: nn Signal strength nn (nn = 6 to 30) 
cccccc Message counter (Total no. Of messages sent by logger) 
ZZZZLLL Zone/Location details  
RDL634LF/3131 Logger part number  
P000.1 Channel 1 – calibration value (P = Pressure) 
F010.0 Channel 2 – Litres/pulse (F = Flow) 
P000.1 Channel 3 - calibration value (P = Pressure) 
F100.0 Channel 4 - Litres/pulse (F = Flow) 
Sno 00123 Serial number of data logger 
Dom 03-04-04 Date of manufacture of data logger (dd-mm-yy) 
High Street Test Comment in logger 

 
If the zone/location already exists in the Database or the telephone number has already been used by 
another zone/location Autocall will send one of the following messages to the originator of the “Config” 
message. 
 
 

Table B 5 – Zone Location Exists SMS Text Message 
 

Message Description 
FAILED  
+44776411111 Telephone number of original 

caller 
V 01.00 Firmware version in Logger. 
+CSQ: nn Signal strength nn (nn = 6 to 30) 
ZZZZLLL Zone/Location details  
RDL634LF/3131 Logger part number  
Sno 00123 Serial number of data logger 
Location ZZZ/LLLL already 
exists in the database 
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Table B 6 – Zone Telephone No. Exists SMS Text Message 

 
Message Description 
FAILED  
+44776411111 Telephone number of original 

caller 
V 01.00 Firmware version in Logger. 
+CSQ: nn Signal strength nn (nn = 6 to 30) 
ZZZZLLL Zone/Location details  
RDL634LF/3131 Logger part number  
sno 00123 Serial number of data logger 
Tel number already exists in the 
database for location zzz/llll 

 

 

Logger Status Message 

“MinN#” Minimum Flow/Pressure for channel N 
 
When the logger receives the SMS text message “MinN#”, where N = 1 to 4 indicating the channel number, 
from a telephone number, it replies with following message. 
 

Table B 7 – MinN# SMS Text Message 
 

Message Description 
Min Original command text without # 
V 01.00 Firmware version in Logger. 
+CSQ nn Signal strength nn (nn = 6 to 30) 
cccccc Message counter (Total no. Of messages sent by logger) 
High Street Test Comment in logger 
Chx – Flow Channel type is Flow or Pressure (Litres/hour or Metres) 
25-12-04 Date of Day 1 (Today)  
1 dddddd Day1 - Minimum (Part of day – since midnight) 
2 dddddd Day2 - Minimum  
3 dddddd Day3 - Minimum (Litres/hour or Metres) 
  
7 dddddd Day7 - Minimum Flow in Litres/hour 

 
• Day 1 is 24 hours long starting at midnight. 
• Day 2 = previous day to day 1 
• Day 3 = previous day to day 2 etc. 
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“MaxN#” Maximum Flow/Pressure for channel N 
When the logger receives the SMS text message “MaxN#”, where N = 1 to 4 indicating the channel number, 
from a telephone number, it replies with Maximum values in the same format as the “MinN#” above (See 
Table B 7). 
 

“SumN#” Data summary for a flow channel N 
When the logger receives the SMS text message “SumN#”, where N = 1 to 4 indicating the channel number, 
from a telephone number, it replies with following message. 
 

Table B 8– SumN# SMS Text Message 
 

Message Description 
Sum Original command text without # 
V 01.00 Firmware version in Logger. 
+CSQ nn Signal strength nn (nn = 6 to 30) 
cccccc Message counter (Total no. Of messages sent by logger) 
High Street Test Comment in logger 
Chx - Flow Channel type is Flow only (Not for pressure)  
25-12-04 Date of Day 1 (Today) 
1 dddd.dd Day1 - Flow in Cubic Metres (Part of day – since midnight) 
2 dddd.dd Day2 - Total Daily Flow in Cubic Metres  
3 dddd.dd Day3 - Total Daily Flow in Cubic Metres  
  
7 dddd.dd Day7 - Total Daily Flow in Cubic Metres 

 
• Day 1 is 24 hours long starting at midnight 
• Day 2 = previous day to day 1 
• Day 3 = previous day to day 2 etc. 

 
The “SumN#” message only applies to a flow type channel. It does not apply to a pressure type channel. If 
this message is sent to a logger where channel N is a pressure channel, the logger will respond with a 
message replacing the summary data with nothing. 
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“Win#” SMS parameters 
When the logger receives a SMS text message “Win#”, from a telephone number, it replies with the following 
message. 
 

Table B 9 – Win# SMS Text Message 
 

Message Description 
Win Original command text without # 
V 01.00 Firmware version in Logger. 
+CSQ nn Signal strength nn (nn = 6 to 30) 
cccccc Message counter 
High Street Test Comment in logger 
+447766222222 
 (10:22) 

1st. Enabled - Telephone Number & call out time. (Last 
14 – digits) 

+447766333333 
 (06:22) 

2nd. Enabled - Telephone Number & call out time. (Last 
14 – digits)  

W1(06:00–08:00) 1st Enabled - Window times 
W3(11:30–18:45) 2nd Enabled - Window times 

 
 

“Totl#” Total volume for all flow channels 
When the logger receives a SMS text message “Totl#”, from a telephone number, it replies with the following 
message. 
 

Table B 10 – Totl# SMS Text Message 
 

Message Description 
Totl Original command text without # 
V 01.00 Firmware version in Logger. 
+CSQ: nn Signal strength nn (nn = 6 to 30) 
cccccc Message counter (Total no. Of messages sent by logger) 
ZZZZLLL Zone/Location details  
RDL634LF/3131 Logger part number describing input configuration. 
High Street Test Comment in logger 
15:15 -24/12/04 Time & date of Total Volume 
Ch2-Flow  Channel Type = Flow 
00000279.11 Total volume (meter reading) in cubic metres. 
Ch4-Flow   Channel Type = Flow 
00002711.10 Total volume (meter reading) in cubic metres. 

 
If there are NO flow channels fitted to the logger it will return blanks in place of the total volumes. 
Meter reading resolution is 10 litres. 
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Annex C  – MultiLog Calibration 

This annex provides the information needed to calibrate Radcom data loggers with infra-red or serial 
communication ports (e.g. Lo-log, Multi-log, Centurion etc.). The annex provides a detailed description on the 
usage of the commands to calibrate, re-zero and check the individual channels of the loggers. It also 
explains how the loggers will respond to each command. 
 
WARNING 
The calibration procedure must be carried out with great care, as it is possible to lose the existing 
calibration details stored inside the logger. It is recommended that only an experienced operator 
should carry out this operation. 
 
C1. Logger Calibration 
 
Select Radcom Manual Call from the start menu. 
 
Make sure the communications port is configured correctly by selecting Basic Configuration from the 
Configuration drop-down menu 
 
Select Advanced Download/Upload/Utilities from the Options drop-down menu 
 
Click on the OK button if the following message appears 
 

 
 
Check/change the Logger Type is set to MultiLog Flash GSM/SMS on the Advanced 
Download/Upload/Utilities screen (See below). 
 
Change the Baud Rate to the required setting using the Baud drop-down menu. 
 
Check/change the Connection type required using the Connection drop-down menu (see Figure C 1 below). 
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Figure C 1 – Advanced Download/Upload/Utilities screen 
 
Click on the OK button. 
 
Select the Utilities tab now shown on the Advanced Download/Upload/Utilities screen and click in the 
Calibrate Logger box (See below). 
 
Click on the OK button. 
 

 
 

Figure C 2 – Calibrate Logger, Utilities Tab, Advanced Download/Upload/Utilities 
 
If the logger is fitted with more than one analogue channel (pressure/milliAmp) an option screen for choosing 
the required channel will appear (see Figure C 3 below). 
 
Select the required channel number from the drop-down menu and click on the OK button. 
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Figure C 3 – Calibration Channel Select Screen 
 
Apply a pressure of 0 Bar to the data logger (equivalent to the transducer being open to the atmosphere). 
 
The Calibrate Logger Screen opens (see Figure C 4) and a flow of values will start to appear in the Low 
column. Allow the raw Numbers in the Low column to stabilize. 
 
Click on the Accept this LOW VALUE button when the low figure values are acceptable. 
 

 
 

Figure C 4 – Low Value, Calibrate Logger Screen 
 
Apply a pressure of 10 Bar to the Logger (assuming that the high pressure is set at 10 bar). 
 
A flow of values will now appear in the High column of the Calibrate Logger screen (see Figure C 5 below). 
The Raw values in the High columns should increase and be higher than the values in the Low column. 
 
Click on the Accept this HIGH VALUE button when high figure values are acceptable. 
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Figure C 5 – High Value, Calibrate Logger Screen 
 
 
The Calibration Options screen will then appear (see Figure C 6) allowing the operator the choice of either 
storing, re-calibrating or aborting the logger calibration by clicking into the required Channel Options box 
and clicking on the OK button. 
 

 
 

Figure C 6 – Calibration Options Screen 
 
If the Store New Values box is checked the Store the new Calibration Values screen appears. Click on 
the YES button to store the values. 
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C2. Re-Zero 
 
Open the Advanced Download/Upload/Utilites screen using the procedures from the Logger Calibration 
section (see Clause C.1). 
 
Click in the Re-Zero Logger box and click on the OK button. 
 

 
 

Figure C 7 – Re-Zero Logger, Utilities Tab, Advanced Download/Upload/Utilities 
 
If the logger is fitted with more than one analogue channel (pressure/milliAmp) an option screen for choosing 
the required channel will appear (see Figure C 3 below). 
 
Select the required channel number from the drop-down menu and click on the OK button. 
 

 
 

Figure C 8 – Re-Zero Channel Select Screen 
 
A flow of values will then appear in the Zero column of the Re-Zero Logger screen. Allow the raw Numbers 
in the Zero column to stabilize (see Figure C 9 below). 
 
Click on the Accept this ZERO VALUE button when the Zero figure values are acceptable. 
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Figure C 9 – Re-Zero Logger Screen 
 
The Re-Zero Options screen will then appear (see Figure C 10 below) allowing the operator the choice of 
either storing, re-zeroing or aborting the Re-Zero by clicking into the Channel Options box and clicking on 
the OK button. 
 

 
 

Figure C 10 – Re-Zero Options Screen 
 
If the Store New Values box is checked the Store the new Zero Value screen appears. Click on the YES 
button to store the values. 
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C3. Check Calibration 
 
Open the Advanced Download/Upload/Utilites screen using the procedures from the Logger Calibration 
section (see Clause C.1). 
 
Click in the Check Calibration box and then click on the OK button (see Figure C 11). 
 

 
 

Figure C 11 – Check Calibration, Utilities Tab, Advanced Download/Upload/Utilities 
 
If logger is fitted with more than one analogue channel (pressure/milliamp) an option screen for choosing the 
required channel will appear (see Figure C 12 below). 
 
Select the required channel number from the drop-down menu and Click OK. 
 

 
 

Figure C 12 – Calibration Check Channel Select Screen 
 
 
A flow of values will then appear in the Time and Value columns of the Check Calibration screen. Allow the 
raw Numbers in the Value column to stabilize (see Figure C 13 below). 
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Figure C 13 – Check Calibration Screen 
 
 
If the test is left to run the following Comms Timed Out error screen will eventually appear. 
 

 
 
 
If the operator clicks on the Abort button the following Comms Aborted by User error screen will appear. 
 

 
 
Click on the OK button to return to the Utilities tab on the Advanced Download/Upload/Utilities screen. 
 
The operator can then re-calibrate or Re-Zero if the values are unacceptable. 
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Annex D  – GSM Signal Strength Measurement 

It is possible to utilize the logger to measure the signal strength of the GSM network. This measurement can 
be taken during the installation of the logger, to position the antenna for optimal signal strength, or as a 
diagnostic check if the operator experiences any problems with telemetry data transfer. 
 
To check the GSM signal strength, proceed as follows: 
 
Select Radcom Manual Call from the start menu. 
 
Make sure the communications port is configured correctly by selecting Basic Configuration from the 
Configuration drop-down menu. 
 
Select Advanced Download/Upload/Utilities from the Options drop-down menu. 
 
Click on the OK button if the following message appears; 
 

 
 
Check/change the Logger Type is set to MultiLog Flash GSM/SMS on the Advanced 
Download/Upload/Utilities screen (see Figure D 1 below). 
 
Change the Baud Rate to the required setting using the Baud drop-down menu. 
 
Check/change the Connection type using the Connection drop-down menu. 
 

 
 

Figure D 1 – Advanced Download/Upload/Utilities screen 
 
Click on the OK button. 
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Select the Utilities tab now shown on the Advanced Download/Upload/Utilities screen and click in the 
Monitor Signal Strength box (see Figure D 2 below). 
 

 
 

Figure D 2 – Monitor Signal Strength, Utilities Tab, Advanced Download/Upload/Utilities screen 
 
Click on the OK button. 
 
The Monitor Signal Strength screen will now appear showing the values of the test in the Signal and 
Quality columns (see Figure D 3 below). 
 

 
 

Figure D 3 – Monitor Signal Strength screen 
Note 

Please wait for the logger to initialise. It may take up to two minutes for the logger to register with the network and 
display the signal strength values. 

 
The antenna can be moved around to achieve optimal signal strength while checking the signal strength. 
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The minimum signal strengths required for successful telemetry communications are as follows: 

SMS communications signal strength should be at least 6. 
GSM data communications signal strength should be at least 13. 

 
 
If the test is left to run the following Comms Timed Out error screen will eventually appear. 
 

 
 
 
If the operator clicks on the Abort button the following Comms Aborted by User error screen will appear. 
 

 
 
Click on the OK button to return to the Utilities tab on the Advanced Download/Upload/Utilities screen 
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Annex E  – Instantaneous Values of the Logger Input 

 
Measurements being taken by the data logger can be viewed in real time using the Radcom Manual Call 
software. 
 
To view Instantaneous Values from the logger, proceed as follows: 
 
Select Radcom Manual Call from the start menu. 
 
Make sure the communications port is configured correctly by selecting Basic Configuration from the 
Configuration drop-down menu 
 
Select Advanced Download/Upload/Utilities from the Options drop-down menu 
 
Click on the OK button if the following message appears: 
 

 
 
Check/change the Logger Type is set to MultiLog Flash GSM/SMS on the Advanced 
Download/Upload/Utilities screen (see Figure E 1 below). 
 
Change the Baud Rate to the required setting using the Baud drop-down menu. 
 
Check/change the Connection type using the Connection drop-down menu. 
 

 
 

Figure E 1 – Advanced Download/Upload/Utilities screen 
 
Click on the OK button. 
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Select the Utilities tab now shown on the Advanced Download/Upload/Utilities screen and click in the 
Instantaneous Value box (see Figure E 2 below). 
 

 
 

Figure E 2 – Instantaneous Values, Utilities Tab, Advanced Download/Upload/Utilities screen 
 
Click on the OK button. 
 
The Instantaneous Value screen will now appear showing the channel values being read by the logger (see 
Figure E 3 below). 
 
Note 

The readings for the channels shown are Metres Head and Litres per second, normal readings will depend on the 
input signal type and transducer configuration details. 

 

 
 

Figure E 3 – Instantaneous Value screen 
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If the readings are left to run the following Comms Timed Out error screen will eventually appear. 
 

 
 
 
If the operator clicks on the Abort button the following Comms Aborted by User error screen will appear. 
 

 
 
Click on the OK button to return to the Utilities tab on the Advanced Download/Upload/Utilities screen 
 


